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O. VEM GYAKORLAT  

(PR, HP) 

Bevezető 

A Végeselem módszer (VEM) egy numerikus módszer parciális differenciálegyenletek közelítő 

megoldására.  

Jellemzően gépész- és építőmérnökök használják mechanikai (szilárdságtani és lengéstani) 

feladatokkal kapcsolatos számítások elvégzésére. 

Tipikus példa a végeselem módszer használatára egy bonyolult alakú statikusan terhelt gépalkatrész 

feszültségi állapotának és alakváltozásának meghatározása. Ebben az esetben az alkatrészt 

modellező testet véges számú elemekre bontják (síkbeli problémáknál háromszögekre vagy 

négyszögekre térbeli esetben hasábokra vagy tetraéderekre). A felosztást célszerű úgy végrehajtani, 

hogy azokon a részeken, ahol a megoldás szempontjából kritikus az eredmény, ott sűrűbben kisebb 

méretű elemet, ahol pedig a változások várhatóan kisebb méretűek lesznek, ott nagyobb méretű 

elemet választunk. A modellekben az elemek csak csomópontjaikon csatlakoznak egymáshoz. A 

csomópontokon az elemekre ható erők és a csomópontok elmozdulása között, -izotróp (Hooke-

törvényt követő) anyag esetén-, lineáris összefüggés áll fenn, ezekből összeállítható az elemek 

merevségi mátrixa, amelyekből aztán az egész feladat merevségi mátrixa létrehozható. A feladat 

statikai számítások esetén az alábbi egyenletre redukálódik: 

Kq F  

Az egyenletrendszer megoldásával kiszámítható az egyes csomópontok elmozdulása, majd az 

elmozdulásokból a csomóponti erők és a közelítő mechanikai feszültségek. A statikus probléma tehát 

végső fokon egy lineáris egyenletrendszer megoldását kívánja, amelyre sok jól használható 

számítógépes módszert dolgoztak ki. 

1 ELMÉLETI ÖSSZEFOGLALÓ 

Egyszerűbb alkatrészek (rudak, vastag falú csövek, tárcsák, tartályok) a szilárdságtan 

hagyományos/klasszikus módszereivel megoldhatók (különböző elméletek léteznek, melynek 

képletei segítségével kiszámíthatjuk a kialakuló feszültségállapotot) 

Bonyolult alkatrészek esetén (pl. főtengely, forgattyúház) nem alkalmazhatók a szilárdságtan 

klasszikus módszerei. Ezekre a feladatokra egy numerikus közelítő módszert fogunk alkalmazni, 

melynek lényege hogy az alkatrészt feldaraboljuk sok kisebb, egyszerű alakú elemre (pl. 3D esetén 

kocka, prizma, piramis, tetraéder) (Szóval inverz LEGO-zunk) és az elmozdulásokat közelítjük 

elemenként. 

Egy szilárdságtani feladat esetén: 

Adott (vagy legalábbis úgy véljük, hogy adott): 

 az alkatrész geometriája 

 az alkatrész anyaga 

https://hu.wikipedia.org/wiki/Line%C3%A1ris_egyenletrendszer
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 a terhelések 

 a megtámasztások 

Meg szeretnénk határozni: 

 az elmozdulásmezőt 

 az alakváltozás mezőt 

 a feszültségmezőt 

A Megoldás menete végeselem-módszerrel: 

 Végeselem hálózás: A testet felbontjuk a fent említett egyszerű kis elemekre. Ezeknek az 

elemeknek csomópontjai vannak (a csúcsokban mindig, ezen kívül még az oldalak 

felezőpontjába is rakhatunk csomópontokat) Az elemek ezen csomópontok által vannak 

definiálva és az elemek a csomópontokban kapcsolódnak egymáshoz. Az elemeket és a 

csomópontokat is sorszámozzuk. Attól függően, hogy pl. rúddal, lemezzel vagy 3D testtel van 

dolgunk 1D-s, 2D-s vagy 3D-s elemeket alkalmazhatunk (3D elemeket elvileg bármikor tudunk 

alkalmazni, de a speciális feladatoknál (rúd, lemez) drasztikusan megnöveli a számítást, vagy 

hülyeséget kapunk, ezért kerülendő) 

 
 

Néhány példa végeselem modellekre: 
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 Az elmozdulásmezőt elemenként közelítjük valamilyen polinommal, amelyek a 

csomópontokban illesztünk (keresztülmennek a csomópontokon) 

 A közelítő elmozdulásmezőből a geometriai és anyagegyenletek segítségével előállítjuk a 

közelítő alakváltozási meg feszültségmezőt aztán ha ez megvan akkor egy megfelelő 

módszerrel (Lagrange féle variációs elv) egy egyszerű lineáris algebrai egyenletrendszerhez 

jutunk: 

Kq F  amiből 
1

q K F


  

ahol K a merevségi mátrix, F a terheléseket tartalmazó oszlopvektor, q a csomópontok 

közelítő elmozdulása 

Ha a dinamikai hatásokat is figyelembe vesszük, akkor egy picit bonyolultabb egyenletet kell 

megoldanunk: 

( ) ( ) ( ) ( )M q t Dq t Kq t F t    

 A csomópontok közelítő elmozdulásából megkapható a közelítő alakváltozási és 

feszültségmező. 

2. VÉGESELEMES PROGRAMRENDSZER ÁLTALÁNOS FELÉPÍTÉSE 

1. PREPORPCESSING (adatbeviteli rész) 

 geometria megrajzolása (a végeselem program beépített CAD programjával) vagy 

importálás külső CAD programból 

 Szerkezet anyagjellemzőinek megadása: 

o statikus vizsgálat esetén: rugalmassági modulus (E), Poisson tényező ( ) 

o dinamikus vizsgálat esetén: a fentieken kívül még sűrűség 

o rúdfeleadat esetén még meg kell adni a keresztmetszeti jellemzőket (A, I), 

lemezfeladat esetén meg a vastagságot (ezek a programokban általában nem 

az anyagjellemző bevitel részen kell megadni) 

 Szerkezet végeselem hálózása (elemek alakjának, méretének megadása) 

 Szerkezet terhelésének megadása (koncentrált erő, nyomaték, megoszló terhelés, 

hőmérséklet…) 

 Szerkezet megtámasztásának megadása (megfogás/rugalmas ágyazás) 

 Több egymáshoz kapcsolódó alkatrész esetén a kontaktok definiálása 

2. SOLVING (végeselem-számítás rész) 

 Lényegében a megoldó futtatását jelenti. Ez a szakasz az, amely a felhasználó elől 

leginkább rejtve marad. 

 a program elkészíti a merevségi mátrixot (illetve tömeg és csillapítási mátrixot 

dinamikai feladat esetén) illetve a terhelések vektorát 

 a program megoldja a lineáris algebrai egyenletrendszert (illetve a mozgásegyenletet 

dinamikai feladat esetén), ebből kijönnek a csomóponti elmozdulások, majd 

kiszámítja a kívánt származtatott mennyiségeket (alakváltozási-, feszültség mező) 
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3. POSTPROCESSING (kiértékelő rész) 

 Megadjuk, hogy milyen eredményeket szeretnénk látni (pl. elmozdulás, alakváltozás, 

redukált feszültség…) – ezeket általában szép színes ábrák formájában kapjuk meg, 

amiket le is animálhatunk. 

Elterjedt végeselem programok: 

 PREPROCESSOR: Ansa, Hypermesh, Truegrid 

 POSTPROCESSOR: Meta, Animator 

 TELJES PROGRAMRENDSZEREK: Ansys, Abaqus, Nastran, Comsol 

 

3. AZ ANSYS PROGRAMRENDSZER 

Az ANSYS egy átfogó szimulációs szoftvercsomag, mely a fizika minden területét átöleli, 

lehetőséget biztosít valamennyi gyakorlatban előforduló mérnöki szimulációra. 

 

Ansys letöltése: ansys.com/student 

 
 

 

Az ANSYS-t 4-féle módon is használhatjuk: 

1) GUI nélkül 

Megnyitunk egy szimpatikus szövegszerkesztőt és az Ansys programnyelván (APDL – 

Ansys Parametric Design Language) megírjuk a végeselemprogramunkat (a profik 

általában így csinálják) 

2) GUI-val – ebből 3 is van az ANSYS-nak: 

 Ansys Classic (Mechanical APDL): ez a legrégebbi GUI. Minden funkció elérést 

biztosítja, viszont használata nehézkesebb, használata komolyabb 

szimulációkhoz célszerű 
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 Ansys Workbench: előnye a könnyen kezelhető és átlátható kezelőfelület, ami 

sok automatizmussal segíti a felhasználót. Viszont ennek hátránya, hogy 

némelyik funkció közvetlenül nem érhető el benne 

 Ansys AIM: ez a legújabb GUI. A Workbench-en alapul, de még annál is 

könnyebben kezelhető. Viszont ez a legbutább. 

Mi leginkább a Workbench-et fogjuk használni. 

 

4. ANSYS WORKBENCH FELÉPÍTÉSE 

 

Indítsuk el az ANSYS Workbench 14.0-t. 

1. Fent a Units fülön állítsuk be a mértékegységet az ábrának megfelelően. 

 
 

2 Fő ablak jelenik meg, a Toolbox és a Project Schematic. 

A Toolbox 5 alcsoportot tartalmaz, melyek elemeit a Project Schematic ablakba 

húzhatjuk. A  számunkra legfontosabb két alcsoport: 

 Analysis systems: előre definiált sablonok, amikkel egy teljes vizsgálat 

lefolytatható. 

 Component systems: komponensek, amelyeket hozzárendelhetünk a 

sablonokhoz. 

Az Analysis systems-ben található sablonok: 

 Eigenvalue Buckling: kihajlás vizsgálat 

 Explicit Dynamics: ütközés, ejtés vizsgálat (rövid idő alatt nagy alakváltozás) 

 Electric: elektromosságtan 

 Fluid Flow: áramlástani szimulációk 

 Harmonic Response: frekvenciaátviteli függvények meghatározása (egy 

alkatrészt valahol harmonikusan gerjesztek akkor mekkora lesz a rezgés 

amplitúdója ugyanabban, vagy bármely más pontban a frekvencia 

függvényében) 

 Modal: sajátfrekvencia, lengéskép 

 Response Spectrum: tranziens terhelésre adott maximális válasz 
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 Static Structural: időfüggetlen terhelés hatására kialakuló állandósult 

deformáció, feszültség (dinamikai jellemzőket nem veszi figyelembe). A 

megoldandó egyenlet: 

Kq F
 

 Rigid Dynamics: több, egymáshoz kapcsolódó merev testből álló szerkezet 

dinamikai vizsgálata (MBS = Multi Body Simulation) 

 Steady State Thermal: hőmérsékleteloszlás állandósult állapotban 

 Transient Thermal: hőmérsékleteloszlás az idő függvényében 

 Transient Structural: időfüggő terhelésre adott dinamikus válasz (timehistory 

analysis). Az alábbi mozgásegyenletet oldja meg a program: 

( ) ( ) ( ) ( )M q t Dq t Kq t F t  
 

Ennek a megoldása bonyolultabb szerkezeteknél rendkívül időigényes, ezért 

ha van rá lehetőség, kerülni kell 

o ha dinamikai hatás elhanyagolható: Static Structural 

o ha a gerjesztés harmonikus: Harmonic Response 

o ha az alkatrészek merevek, és csak a kinematikai jellemzők érdekelnek: 

Rigid Dynamics. 

Mi a fentiekből csak a Static Structural-t, illetve a Modal-t fogjuk használni. 

 

Ha eltűnnének dolgok, a munkafelületet a View→Reset Workspace-szel tudjuk helyrerakni. 

A Tools→Update Project-tel frissíthetjük a munkánkat (pl. ha utólag módosítottunk a 

geometrián). 

5. STATIC STRUCTURAL MODUL BEMUTATÁSA 

Húzzuk át az egérrel a Static Structural modult az Analysis Systemsből a Project Schematic 

ablakba. Tekintsük át az itt látható 6 pontot: 

komponens neve  használt alprogram 

Engineering Data anyagjellemzők megadása Engineering Data 

Geometry geometria megrajzolása Design Modeler 

Model végeselem háló elkészítése 

Mechanical 
Setup megfogások, terhelések megadása 

Solution a program megoldja a feladatot 

Results eredmények megjelenítése 
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A komponensek után látható ikonok: 

 hiányzó adat 

 lehetséges, hogy javítani kell valamit 

 frissíteni kell 

 frissíteni kell, az adatok megváltoztak, ami hatással van a többi komponensre is 

 frissített 

 változások vannak függőben 

 

1. Engineering Data – anyagjellemzők megadása: 

Itt alapból egy pipa látható, mivel a program alapértelmezésként feltételezi, hogy acélt 

szeretnénk használni. Tehát csak akkor szükséges ezt módosítani, ha nem acélt szeretnénk 

használni. Ebben az esetben: 

Kattintsunk duplán az Engineering Data-ra. Most két lehetőségünk van: 

1. Választunk egyet a beépített anyagok közül: ezt fent az Engineering Data Sources-re 

kattintva tudjuk megtenni. 

 
2. Új anyagot definiálunk: kattintsunk a Click here to add a new material-ra, majd írjuk 

be az új anyag nevét.  

 
Ezután a jobb oldali Toolbox-ból húzzuk rá az új anyagunkra a Linear Elastic alól az 

Isotropic Elastic-ot (már ha lineárisan rugalmas, izotrópikus az anyagunk, mi csak 

ilyennel foglalkozunk), modálanalízis esetén még a Physical Properties alól húzzuk rá 

az anyagunkra a Density-t. 
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A lent megjelenő sárga cellákba írjuk be az anyagjellemzőket.

 

 

 Ügyeljünk a mértékegységekre (MPa, tonna mm^-3) 

 A tizedesjel vessző a Workbenchben! 

Térjünk vissza a főképernyőre. Ehhez fent x-eljük be az Engineering Data-t (régebbi 

verziókban Return To Project gombra kell kattintani). 

 

 

2. Geometry – Geometria definiálása 

Geometriát kétféle képen varázsolhatunk: importálunk egyet vagy rajzolunk.  

a) Geometria importálása: Kattintsunk jobb egérgombbal a Geometry-re és válasszuk a 

helyi menüből az Import Geometry → Browse-t 

 

*.igs, *.stp file – okat gond nélkül importálhatunk, de ezen kívül az Ansys támogatja a 

legtöbb CAD szoftvert (pl Creo *.prt, *.asm is gond nélkül importálható). 

FONTOS! A CAD modellek általában a gyártáshoz készülnek, nem pedig a 

szimulációhoz. Vannak olyan részletek, amelyekre a szimuláció szempontjából 
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nincsen szükség, illetve olyan részletek, amik viszont kellenének a szimulációhoz, de a 

CAD modell nem rendelkezik velük. Ezért szimuláció előtt fontos a CAD modell 

megfelelő előkészítése. Pár példa: 

 tüntessük el a teljesen felesleges dolgokat (pl. logok), 

 a terheletlen részeken egyszerűsítsük a geometriát (pl. letörések eltávolítása, 

olajzófuratok eltávolítása, bordák eltávolítása) ez nagymértékben 

leegyszerűsíti az alkatrész végeselemekre való bontását, 

 ha vannak menetek, azokat távolítsuk el (akár ténylegesen meg van rajzolva, 

akár szimbolikus – utóbbit felületként értelmezné az Ansys és megzavarná), 

 terhelések, megfogások, esetleg kontaktok megadásához célszerű még a CAD 

szoftverben felületeket definiálni, 

 ha szimmetrikus az alkatrész, valamint a megfogás és terhelés is, elég az 

alkatrésznek csak a felét, negyedét alkalmazni. 

b) Geometria megrajzolása az ANSYS beépített CAD programjával 

Az ANSYS-nak 2-féle beépített CAD programja is van, a Design Modeler, illetve a 

SpaceClaim (régebbi verziókban csak a Design Modeler van, mi is ezt fogjuk 

használni, mivel régi az Ansysunk). 

A Geometry helyi menüjéből a Properties-re kattintva jobboldalon megjelenik egy 

ablak. Attól függően, hogy 2D vagy 3D feladatot akarunk vizsgálni, az Analysis Type-

nál állítsuk be a 2D vagy 3D-t (alapértelmezésként 3D van, tehát ez csak 2D feladatnál 

fontos). 

A Design Modeler elindításához kattintsunk duplán a Geometry-re. 

 

Fent állítsuk be a mértékegységet: 

 
Mozgatás: 

középső egérgomb görgetése: zoomolás 

középső egérgomb nyomvatartása mellett egér mozgatása: forgatás 

Ctrl + középső egérgomb nyomvatartása mellett az egér mozgatása: tologatás 

Ha egy kívánt síkot szeretnénk látni, kattintsunk a síkra merőleges tengelyre: 
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Felső menüsor fontosabb ikonjai (amiket használni is fogunk):  

Selection filter 

 
Az 1. ikonnal választhatunk, hogy egyenként (single select), vagy egy téglalappal (box 

select) csoportosan akarunk objektumokat kijelölni. 

A többi ikon rendre: pont kijelölése, él kijelölése, felület kijelölése, test kijelölése. 

New sketch: ezzel tudunk egy új vázlatot készíteni 

 
New Plane: új síkot tudunk létrehozni 

 
Generate: Ezzel tudjuk véglegesíteni a különböző parancsokat (pl. egy extrudálást)

 
3D eszközök: Miután készítettünk egy vázlatot, ezzel tudunk 3D testet létrehozni.

 
 Extrude: kihúzás, 

 Revolve: körbeforgatás egy adott tengely körül, 

 Sweep: végigsöprés egy adott görbe mentén. 

Vázlat készítése: A Tree Outline-ban kattintsunk arra a síkra, amelyen el szeretnénk 

készíteni a vázlatot, majd a New Sketch-re a fenti menük közül. Ekkor az adott sík 

alatt megjelenik egy Sketch1. 

 

A vázlat elkészítéséhez váltsunk át a Sketching fülre. 
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A Sketching eszköztár főbb parancsai: 

 Draw: különböző alakzatokat rajzolhatunk 

 Line = vonal rajzolása 

 Tangent Line = érintő vonal 

 Line by 2 tangent = 2 ívhez hozzásimuló egyenes 

 Polyline = törtvonal 

 Rectangle = téglalap 

 Rectangle by 3 points = téglalap 3 pont által definiálva 

 Circle: kör 

 Circle by 3 tangents: kör 3 vonal által definiálva 

 Arc by Tangent: körív 2 egyenes által definiálva 

 Arc by 3 Points: körív 3 ponttal definiálva 

 Arc by Center: körív középponttal és sugárral definiálva 

 Ellipse: ellipszis 

 Construction Point: pont 

Megjegyzések: 

 Rajzolás közben a vízszintes, függőleges tengelyre, origóra, illetve a már 

megrajzolt alakzatokra automatikusan (rá)csatlakozunk, amit egy C betű jelez 

(tehát a coincident kényszer alapból be van kapcsolva). Ezen kívül a vertical és 

horizontal kényszerek is alapból be vannak kapcsolva, így ha egy vonal húzása 

során meglátjuk a H vagy V betűket, akkor a vonalunk garantáltan vízszintes, 

vagy függőleges lesz, még ha nem is annak látszik pillanatnyilag. 

 Polyline esetén célszerű a helyi menüből a Close end segítségével visszatérni a 

kezdőpontba. 



13 
 

 

Modify: módosításokat hajthatunk végre a rajzunkon. 

 Fillet: lekerekítés 

 Chamfer: letörés 

 Trim: levágás 

 Extend: meghosszabbítás 

 Offset: párhuzamos rajzolása 

Megjegyzés: 

 A lekerekítés és letörés mértékét a Fillet és a Chamfer sorában tudjuk 

megadni. A rajzon kattintsunk arra a két vonalra, amely között kerekítést vagy 

letörést szeretnénk létrehozni. 

 

Dimensions: méretezzük a rajzot: 

 General: általános méret (a program megpróbálja kitalálni, mit akarunk) 

 Horizontal: vízszintes méret 

 Vertical: függőleges méret 

 Length/distance: hossz/távolság 

 Radius: sugár 

 Diameter: átmérő 

 Angle: szög 

 Semi-Automatic: a program automatikusan beméretezi a rajzot 

 Move: mozgathatjuk a méreteket 

 Display: beállíthatjuk, hogy a méret nevét és/vagy értékét akarjuk látni 

A méreteket számszerűen a bal alsó részen, a Details Wiev-ban a Dimensions alatt 

tudjuk megadni: 
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Constraints: különböző kényszereket tudunk megadni. Ezeket a rajzon nem látjuk, 

kitörölni is elég nehéz őket, ha lehet kerüljük őket Ansys-ban. 

Settings: Egy négyzetrácsot tudunk a munkafelületre rakni, amivel egyszerűbb 

alakzatokat gyorsan, utólagos méretezés nélkül meg tudunk rajzolni. 

 Grid: itt kapcsolhatjuk be, illetve bekapcsolhatjuk, hogy csatlakozzunk a 

rácspontokra (ezt mindenképp célszerű bekapcsolni, enélkül nincs sok 

értelme) 

 Major grid spacing: rácsvonalak távolsága 

 Minor-Steps per Major: a fő négyzeteket hány alnégyzetre bontsa fel (ezeket 

szaggatott vonallal jelöli) 

 Snaps per Minor: csatlakozások száma 

Ha elkészült a vázlatunk, menjünk át a modeling fülre, fent jelöljük ki valamelyik 3D opciót 

(mondjuk az extrudálást), jelöljük ki a modelfán a vázlatunkat, majd lent a Details View-ban a 

Geometry mellett kattintsunk az Apply-ra. A kihúzás méretét az FD1 sorában tudjuk 

megadni. Végül fent kattintsunk a Generate-re. 
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Ha végeztünk a geometria megrajzolásával, zárjuk be a Design Modelert. 

 

3. Mechanical 

A végeselem vizsgálathoz kattintsunk duplán a Model-re. Ekkor megnyílik a mechanical. 

Innentől kezdve mindent részfeladatot ebben végzünk (tehát nem kell külön megnyitni majd 

a Setup-ot, Solution-t, Results-ot). 

anyag hozzárendelése testhez: A modellfán a Geometry alatt válasszuk ki a kívánt testet, 

majd lent a Details of „Solid” ban a Material alatt az Assignement mellett válasszuk ki az 

anyagot. 
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Ha nem rendelünk anyagot a testhez, alapértelmezésként acélt rendel hozzá. 

Hálózás 

Elemek típusa:  Mesh → Insert → Method 

 

Ha beraktunk egy Method-ot, lent a Geometry mellett kattintsunk a sárga No Selection-re, 

jelöljük ki azokat a testeket, amelyeken alkalmazni szeretnénk a módszert, majd kattintsunk 

a Geometry melletti Apply-ra. 

Method: 

 tetrahedrons: tetraéderekkel hálóz 

 Hex dominant, Multizone: kocka, piramis és prizma alakú elemekkel hálóz (a 2 más 

algoritmussal építi fel a hálót, célszerű inkább a Multizone-t választani). 

Element Midside Nodes: 

 dropped: lineáris elemeket használ (felső sor) 

 kept: másodfokú elemeket használ (alsó sor) 
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A kocka alakú elemek pontosabb eredményeket adnak, viszont sokkal nehezebb (gyakran 

lehetetlen) egy bonyolult alkatrészt kockákkal behálózni. Ilyenkor másodfokú tetraédereket 

célszerű alkalmazni. 

Sizing: Megadhatjuk az elemek méretét az egész testre, vagy a kijelölt felületekre. A 

feszültséggyűjtő helyeken célszerű sűríteni a hálót. A háló sűrítésével a feszültségértékek 

konvergálnak egy adott értékhez. Modálanalízis során durva háló esetén merevebb a test, 

így magasabb sajátfrekvenciákat kapunk, a háló sűrítésével a sajátfrekvenciák csökkennek, 

konvergálnak a tényleges értékhez. 

A beállítások elvégzése után a Mesh helyi menüjéből a Generate Mesh-sel a program 

elkészíti a hálót. 

Kinematikai és Dinamikai peremfeltételek 

A Static Structural helyi menüjéből az Insert-tel, vagy a fenti menüsorból érhetők el. 

Megfogások: 

 Fixed support: megfog minden szabadságfokot 

 Displacement: állandó/időben változó elmozdulás élre/pontra/felületre 

 Remote Displacement: geometriai elem elmozdulása/elfordulása adott ponthoz 

viszonyítva 

 Frictionless Support: felületi normális irányába történő elmozdulást akadályozza meg 

 Compression only: csak nyomóhatást kifejtő kényszer 

 Cylindrical support: hengeres felület mozgását definiálhatjuk 

 Elastic Support: rugalmas ágyazás (főleg 3D feladatok esetén ezt célszerű alkalmazni 

merev megfogás helyett, viszont ehhez meg ismerni kell a kapcsolódó alkatrész 

rugómerevségét, ami meg általában nem ismert). 

Terhelések: 

 Pressure: nyomás 

 Hydrostatic Pressure: hidrosztatikus nyomás 



18 
 

 Force: erő 

 Remote Force: erő erőkarral 

 Bearing Load: csapágyterhelés 

 Bolt Pretension: csavar előfeszítés 

 Moment: nyomaték 

 Line Pressure: vonal mentén megoszló terhelés 

 Thermal Condition: hőmérsékleti terhelés 

 

Az egyes megfogások, terhelések esetén jelöljük ki a testet/felületet/élt/pontot, amire a 

terhelés/megfogás hat, kattintsunk lent a Geometry mellett az Apply-ra, majd a Definition 

alatt töltsük ki értelemszerűen a sárga cellákat. Erő esetén célszerű a Vektor megadási mód 

helyett a Components-et választani (a Defined By mellett) 

Megjeleníteni kívánt eredmények: 

A Solution helyi menüjéből az Insert-tel, vagy a fenti menüsorból érhetők el. 

 deformation: elmozdulás 

o total: elmozdulás abszolút értéke 

o directional: elmozdulások x, y, z irányokban 

 Stress: feszültség 

o Equivalent (von-Mises): HMH szerinti redukált feszültség 

o Maximum Principal: legnagyobb főfeszültség 

o Middle Principal: középső főfeszültség 

o Minimum Principal: legkisebb főfeszültség 

o Normal: normál feszültség 

o Shear: nyíró feszültség 

 Strain: alakváltozás 

 Energy: alakváltozási energia 

A futtatáshoz a Solution helyi menüjéből kattintsunk a Solve-ra. 


